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Using Camera Measure: 

You can use Camera Measure to preview digital cameras, take snapshots and record videos with 
digital cameras. Camera Measure offers measure tools to help you measure line strip length, 
angle, circle (radius, area), ellipse (radius in x and in y), rectangle, polygon area etc. with live 
video image, still image and video files.  
 
The Camera Measure offers image color enhancement tools, image processing filters and image 
analysis plug-ins. Image enhancement tools help you adjust image color with auto white balance, 
color boost, saturation, contrast, brightness, gamma, gray, image vertical flip and image 
horizontal flip. Image processing filters and image analysis plug-ins help you do real-time industry 
image analysis. With Camera Measure's programmable plug-ins, you can custom your own image 
analysis, pattern recognition, etc. 
 
For more information, click the following topics: 
 
 Getting started with Camera Measure 
 Preview Digital Camera, take snapshots and record videos 
 Apply image effects on camera live video 
 Measure with live videos and images 
 Manage image gallery 
 Tips (Set global drawing properties, dragging image, full-screen displaying and zoom image 

etc.) 
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Getting started with Camera Measure 

Camera Measure runs on Windows XP system or higher version including Vista, Windows 7. With 
a discrete graphics card installing helps Camera Measure running with high speed and high 
quality. 
 
Run the Camera Measure, below figure previewing four cameras together: 

 

 
Preview four cameras together 

 
If you haven’t activated Camera Measure, there is a water mark displaying at the center of image 
displaying window. To remove the water mark, click [[Activate]] menu item in [Help] menu, it 
brings an activating dialog to help you purchasing a key and then activate Camera Measure.  
 
Note: 
If you are on Windows7 system, please run Camera Measure as Administrator to activate.  
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Preview Digital Camera, take snapshots and record videos 

Camera Measure supports multiple cameras. If you have installed several cameras, you can play 
them together or play one of them individually. The menu item [[Preview all Cameras]] in menu 
[Camera] presents this function. Check it or uncheck it to turn on/off the multiple cameras 
previewing together. 
 
Before play a camera, choose the camera in the cameras combo-box: 

 
Choose a camera 

Then click the [Show Camera] button at the right bottom of the software, like below figure:  

 

Configuration camera preview size and still size 

In up figure you can select preview size and still image size for a camera. These settings should 
be set before playing camera. 
 

Take snapshots 

Any time you can get snapshots of one or all cameras by click [Snapshot] button . There are 

more snapshot setting can be found by click menu item [[Snapshot Options…]] in menu [Tools]: 

 
Configuration snapshots 



4 
 

In up figure you can set snapshots saving folder, saving format (bitmap file or jpeg file).  
 
If you have checked the [Automatic Snapshot on timer…] and press the [Snapshot] button to 
begin snapshot, Camera Measure will take snapshots on timer and add them into image gallery. 
 

Record Videos 

Click [Record] button  to record cameras into high quality video files. Click menu item 

[[Video Options]] in menu [Tools] to set recording options before record: 
 

 
Configuration recording 

 
Camera Measure offers two recording video modes: high speed recording mode and direct to 
disk mode. The high speed recording mode records image frames into system memories first, and 
then writes them into disk. This mode doesn’t slow down the camera frame rate, but it needs big 
memory. If you check the [High Speed Recording] in the up figure, this mode is chosen. 
 
In up dialog figure you can turn on/off timer counter in recording video. 
 
Camera Measure supports audio recording with camera recording. Click menu item [[Audio 
Options…]] in menu [Tools] to select audio device and volume. 
 
Recorded videos will be added into image gallery automatically if you allow it. 
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Adjust live video of camera 

During previewing or recording you can adjust live video’s color with auto white balance, 
saturation, brightness, contrast, hue, colorful and color boost. 

Click the button to turn on/off horizontal flip, click the button to turn on/off vertical flip. 

Click the button to turn on/off colorful, click the button to turn on/off color boost. 

Click the button to show below figure to help you turn on/off auto white balance (Don’t 

keep any AWB ON always, the AWB slow down camera speed. It’s better to choose a kind of 
AWB method, after the image color is right, choose “Cancel AWB” to close AWB): 
 

 
Auto White Balance and color adjust 

 
In up figure, you can choose AWB (auto white balance) or set more color by clicking [Advance] 
button: 

 
Color Adjust 
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Apply image effects on camera live video 

Camera Measure offers real-time image processing tools, these are called effect plugins. Effect 
plugins are placed at “.\ Effect” folder with suffix “.effect” filename. 
 
By default there is only one plugin is offered with installation named “QDigitalEffect.effect”. It 
supplies following effects: negative, rgb splitter, sepia, sharpen, solarize and threshold. 

Click the button  to add effects to camera: 

 
Add effect 

 
Some effect has a parameter which can be set, choose an added effect, below figure shows: 

 
Adjust effect parameter 

 
If the effect has more settings, a button named [Advance] will show in up figure. 
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Measure with live videos and images 

Camera measure helps you measure line strip length, angle, circle (radius, area), ellipse (radius in 
x and in y), rectangle, polygon area etc. with live video image, still image and video files. You can 
set weight, fill mode, color and transparency of measurement and save measurement result.  
 
This section shows how to use measure tools of Camera Measure to measure with live video or 
still image. The following tutorials are provided.  
 
 Set measure conversion factor with Ruler 
 Measure everything 
 Show grid to help measure 
 Saving measure 

Set measure conversion factor with Ruler 

The screen displays images in pixels, all measurement are based pixels. The Camera Measure 
software maps screen pixels to object length. The mapping conversion is done by multiplying the 
pixel measurements values by a numeric constant called Conversion Factor.  
 
So before measurement you should set conversion factor by measuring a known length object. 
This is done by the Camera Measure’s ruler. Camera Measure’s ruler is a line displaying in the 
image with two points that can be dragged. 
 
Follow below steps to set the conversion factor with Ruler: 
1. Click button  in top toolbar. 
2. Drag the ruler’s two points, drag one point of the ruler to the known length object’s start 

point, and drag another point to the end of the known length object, like below figure: 
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3. In the ruler’s settings window, input the known object’s real length in the first left edit box, 
and then click the [Real Length] button to complete the conversion factor configuration: 

 

 
Now the conversion factor is set successfully.  
 
You can set a unit string which makes the measurement result more straightforward. For example 
input “cm” in the [Unit edit box] and click the [Unit] button. 
 
For microscope measurement the Camera Measure’s ruler has a magnification tools which is 
useful for switch between different microscope objectives. With magnification tools you don’t 
need to reset real length of the ruler, input magnification in edit box and click [Magnification] 
button. 
 

Click  to load and click  to save current ruler: 

 
Save and load ruler 

Measure everything 

After the ruler is set, choose different measure tools in the toolbar to measure length, angle, 
circle, ellipse, rectangle and polygon area etc. 
 
Each kind of measurement has control points, drag control points to adjust measurement. With 
measurement toolbar, you can set measurement’s drawing color, line weight, fill mode, text color 
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and text height: 

 
Measurement toolbar 

 
Note: 
You can set selecting measurement’s drawing properties and also you can set a global drawing 
properties. Click blank region in image with none measurement selected, then the drawing 
properties are set as global. The global means all new measurements will use these properties. 
 

Click the button to delete selected measurements and click the button  to show/hide 
current selected measurement. 
 
Below is measuring angle sample: 

 

Show grid to help measure 

Camera Measure offers grid tool to help you measure. Click the button  in toolbar, following 

settings is shown: 
 

 
 
If the [Show Grid] is checked, grids shows like: 
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Image with grids 
 
You can set grid’s size and color (including transparency): 

 

Color Selector 

 
There is a track bar in the color selector. It’s used to set color transparency. 
 

Saving measure 

The live video with measurements can be saved as image file or the measurements can be saved 
as txt file individually. 
 

Click the button  in the toolbar to save the editing image as another image file. Click the 
menu item [[Save Measure As…]] in menu [Measure] to save measurements as txt file. 
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Manage image gallery 

There is an image gallery at the bottom of Camera Measure: 
 

 
Image Gallery 

 
Snapshot images and recorded videos are managed here. Click any image in the gallery to bring 
the image to image displaying window and process it. 
 
Double click blank region of the gallery to open image files or video files and add them into 
gallery. Select an item in the gallery, you can remove it from gallery with the button [Remove 

Images] or delete it from disk (press “Shift” key and click the [Remove Images] button). 
 

At the right of the gallery, the button [Show Camera]  brings the camera image into image 

displaying window. 
 
If an image is selected in the gallery, there is an image zoom settings window shown: 

 
Image zoom 

 
If the [Show Camera] is clicked, the camera settings window is shown: 

 
 
In up figure, click the [Advance] brings the camera’s manufacturer settings dialog, click the 
button at the left side, brings the camera image’s zoom settings window. 
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Tips 

Below tips are very useful: 
Set global drawing properties  
Dragging Image in the image displaying window 
Zoom image 
Full-screen displaying 
Slideshow 
 

Set global drawing properties 

You can set selecting measurement’s drawing properties and also you can set a global drawing 
properties. Click blank region in image with none measurement selected, then the drawing 
properties are set as global. The global means all new measurements will use these properties. 
 

Dragging Image in the image displaying window 

You can drag an image while the left “Ctrl” key is pressing. The image can be dragged except for 
the image is displaying with uniform filling mode. 
 

Zoom image 

Click the image display window, with the mouse wheel you can zoom in or zoom out the image. 
And you can double click the image to switch the image displaying mode between 1:1 displaying 
mode and uniform filling mode. 
 

Full-screen displaying 

Right click the image in image displaying window to switch this window between window mode 
and full-screen mode. 
 

Slideshow 

Camera Measure offers slideshow functions to preview all images in image gallery as slideshow 
or generate these images as a slideshow video file. 
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If an image in image gallery is selected this image is chosen as the beginner of the slideshow, else 
the first image is the beginner. 
 
Click menu item [[Preview Slideshow]] in [File] menu to preview the slideshow, click menu item 
[[Generate Slideshow Video]] in [File] menu to generate video file. 
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